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1.0 Introduction 

1.1 Why checkSTRESS? 

It is common practice worldwide that piping designers/layout personnel route pipes with consideration 
given mainly to space constraints, process and flow constraints (such as pressure drop) and other 
requirements arising from constructability, operability and reparability. Unfortunately, often pipe stress 
requirements are not sufficiently considered while routing and supporting piping systems, especially in 
providing adequate flexibility to absorb expansion/contraction of pipes due to thermal loads. So, when “as 
designed” piping systems are given to pipe stress engineers for analysis, they soon realize that the layout 
is “stiff” and suggest routing changes to make the layout more flexible. The piping designers, in turn, 
make routing changes and send the revised layout to the pipe stress engineers to check compliance 
again. Such “back and forth” design iterations between layout and stress departments continue until a 
suitable layout and support scheme is arrived at, resulting in significant increase in project execution time, 
which, in turn, increases project costs.  

This delay in project execution is further aggravated in recent years as operating pressures and 
temperatures are increased in operating plants to increase plant output; increased operating pressures 
increase pipe wall thickness, which, in turn, increase piping stiffness further; increased operating 
temperatures, applied on such “stiffer” systems, increase pipe thermal stresses and support loads. So, it 
is all the more important to make the piping layout flexible at the time of routing by piping designers. 

In order to substantially reduce the number of design iterations between the piping layout and stress 
departments, resulting in huge time savings during design, the “Design by Color” product “checkSTRESS” 
was developed and released in 2010. Since then, a number of enhancements have been added.  

1.2 checkSTRESS Modules 

The preliminary visual pipe stress check software checkSTRESS is an add-on product to: 

 3D Plant Design software PDMS, E3D, PDS and CADMATIC 

 3D Plant Design software that generate “PCF” files from the plant database, such as SmartPlant 
3D, AutoCAD Plant 3D, CATIA, CADWORX, etc. 

The checkSTRESS product performs preliminary visual pipe stress check as follows. 

 Reads the following from the plant database / PCF files of 3D Plant Design software 

 Piping geometry, pipe sections and material properties 

 Temperature, pressure and weight of pipe fittings 

 Thermal anchor movements at equipment nozzles  

 Pipe support details to create the corresponding hangers, guides, etc. in checkSTRESS 

 Allowable loads at equipment nozzles 

 Enables piping code compliance by displaying stress ratio contour plots for Sustained (weight + 
pressure), Expansion and Occasional load cases. 

 Assists in locating hangers and supports by showing deflected shapes for Sustained, Operating, 
Expansion and Occasional load cases. Even sizes variable spring hangers.  

 Generates input files for one or more of the widely accepted pipe stress software CAEPIPE, 
CAESAR II and PIPESTRESS (which is mostly used for nuclear piping analyses). 

 Prints key results such as 10 highest stress ratios and their locations, equipment nozzle load 
compliance with allowable loads, spring hanger report, “active/inactive” status of resting supports 
during operation, Bill of Materials, Weight and Center of Gravity, and Table of Contents. 



 

22  

Currently, the following 3 modules of checkSTRESS are available for license. 

checkSTRESS: generates stress input files only for CAEPIPE 

checkSTRESS II: generates stress input files for CAEPIPE and CAESAR II 

checkSTRESS Nuke: generates stress input files for CAEPIPE and PIPESTRESS 

Excepting the generation of stress input files, the 3 checkSTRESS modules (available for each of the 3D 
Plant Design software listed above) have identical features. Only checkSTRESS Nuke has an additional 
feature of displaying animated mode shapes along with natural frequencies computed. 

1.3 Benefits derived from checkSTRESS modules 

1. During 3D layout stage, the Designer arrives at “flexible pipe routing with even supports including 
spring hanger sizes” to meet the following stress criteria: 

a. Comply with “Thermal Stress”, “Sustained Stress” and “Occasional Stress” requirements for 
ASME and other international piping codes. 

b. Meet the Allowable Nozzle Loads at Equipment Nozzles/Anchors 

2. During 3D layout stage, the Designer identifies all possible locations for pipe supports, as the 3D 
plant model contains all supporting objects such as steel and concrete structures adjacent to the 
concerned piping system. These possible locations for pipe supports, once marked in the 3D 
plant model, are automatically transferred as “nodes” in the input files of pipe stress software. 

3. The Designer transfers stress input files to the pipe stress engineers for mostly “code compliant” 
and “fairly well supported” piping systems. Pipe stress engineers can then import these input files 
into their pipe stress software (thereby avoiding recreation of stress models by pipe stress 
engineers) and perform detailed analyses and stress report preparation. 

4. The Designer confirms the validity of the piping layout finalized with supports by submitting key 
results and relevant plots generated by checkSTRESS. 

1.4 Basic Pipe Stress Concepts for Piping Designers 

Piping systems experience different loadings, categorized into three basic loading types listed below. 

Sustained Load:  

It mainly consists of internal pressure and dead-weight. Dead-weight is from weight of pipes, fittings, 
components such as valves, operating fluid, test fluid, insulation, cladding, lining etc. 

Internal design/operating pressure develops uniform circumferential stresses in the pipe wall, based on 
which pipe wall thickness is determined during the process/P&ID stage of plant design such that “failure 
by rupture” is avoided. In addition, internal pressure develops axial stresses in the pipe wall. These axial 
pressure stresses vary only with pressure, pipe diameter and wall thickness, which are already pre-set at 
the P&ID stage and hence these axial pressure stresses cannot be reduced by changing the piping layout 
or the support scheme. 

On the other hand, dead-weight causes the pipe to bend (generally downward) between supports and 
nozzles, producing axial stresses in the pipe wall (also called “bending stresses”); these bending stresses 
linearly vary across the pipe cross-section, being tensile at either the top or bottom surface and 
compressive at the other surface. If the piping system is not supported in the vertical direction (i.e., in the 
gravity direction) excepting at equipment nozzles, bending of the pipe due to dead-weight may develop 
excessive stresses in the pipe and impose large loads on equipment nozzles, increasing the susceptibility 
to “failure by collapse”.  

Various international piping codes impose limits, also called “allowable stresses for sustained loads”, on 
these axial stresses generated by dead-weight and pressure in order to avoid “failure by collapse”. 
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For the calculated axial stresses to be below such allowable stresses for sustained loads, it may be 
necessary to support the piping system vertically. Typical vertical supports to carry dead-weight are:   

a) Resting steel supports, 

b) Rod hangers, 

c) Variable spring hangers, and 

d) Constant support hangers.. 

Both rod hangers and resting steel supports fully restrain downward pipe movement but permit pipe to lift 
up at such supports. If pipe lifts up at any of the rod hangers / resting supports during operating condition, 
then that support does not carry any pipe weight and hence will not serve its purpose.  

In Appendix F titled “Sample Problems and Solutions using checkSTRESS”, a couple of sample layouts 
are presented to illustrate how piping can be supported by spring hangers and resting steel supports to 
comply with the code requirements for sustained loads. 

Thermal Load (also referred as Expansion Load):  

It refers to the “cyclic” thermal expansion/contraction of piping as the system goes from one thermal state 
to another thermal state (for example, from “shut-down” to “normal operations” and then back to “shut-
down”). If the piping system is not restrained in the thermal growth/contraction directions (for example, in 
the axial direction of a straight pipe), then for such cyclic thermal load, the pipe expands/contracts freely; 
in this case, no internal forces, moments and resulting stresses and strains are generated in the piping. 
 
If, on the other hand, the pipe is “restrained” in the directions it wants to thermally deform (such as at 
equipment nozzles and pipe supports), such constraint on free thermal deformation generates cyclic 
thermal stresses and strains throughout the system as the system goes from one thermal state to 
another. When such calculated thermal stress ranges exceed the “allowable thermal stress range” 
specified by various international piping codes, then the system is susceptible to “failure by fatigue”. So, 
in order to avoid “fatigue failure” due to cyclic thermal loads, the piping system should be made flexible 
(and not stiff). This is normally accomplished as follows: 

a) Introduce bends/elbows in the layout, as bends/ elbows “ovalize” when bent by end-moments, 
which increases piping flexibility. 

b) Introduce as much “offsets” as possible between equipment nozzles (which are normally modeled 
as anchors in pipe stress analysis). For example, if two equipment nozzles (which are to be 
connected by a pipeline) are in line, then the straight pipe connecting these nozzles is “very stiff”. 
If, on the other hand, the two equipment are located with an “offset”, then their nozzles will have 
to be connected by an “L-shaped” pipeline which includes a bend/elbow; such “L-shaped” pipeline 
is much more flexible than the straight pipeline mentioned above. 

c) Introduce expansion loops (with each loop consisting of four bends/elbows) to absorb thermal 
growth/contraction. 

d) Lastly, introduce expansion joints such as bellows, slip joints etc., if warranted.  

In addition to generating thermal stress ranges in the piping system, cyclic thermal loads impose 
loads on static and rotating equipment nozzles. By following one or more of the steps from (a) to 
(d) above and steps (e) and (f) listed below, such nozzle loads can be reduced.   

e) Introduce “axial restraints” (which restrain pipe in its axial direction) at appropriate locations such 
that thermal growth/contraction is directed away from equipment nozzles, especially critical ones. 

f) Introduce “intermediate anchors” (which restrain pipe movement in the three translational and 
three rotational directions) at appropriate locations such that thermal deformation is absorbed by 
regions (such as expansion loops) away from equipment nozzles. 
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In Appendix F titled “Sample Problems and Solutions using checkSTRESS”, a few sample layouts are 
presented to illustrate how loops/offsets, axial restraints and intermediate anchors are used to reduce 
thermal stresses in piping (and resulting nozzle loads).  

Occasional Loads: 

These are the third type of loads, which are imposed on piping by occasional events such as earthquake, 
wind etc. To protect piping from wind (which normally blows in horizontal plane), it is normal practice to 
attach “lateral supports” to piping systems. During an earthquake, the earth may also move vertically. To 
protect piping against both horizontal and vertical movement during earthquake, some of the resting 
supports may be made as “integral 2-way vertical and lateral restraints”. 

checkSTRESS presently performs preliminary visual stress checks only for sustained (mainly dead 
weight, pressure and other sustained mechanical loads), thermal loads, static seismic ‘g’ loads and 
response spectrum loads (uniformly applied at anchors and nozzles). 

Fortunately, to carry sustained loads, normally vertical supports (as those listed under the Section titled 
“Sustained Load” above) are required. To withstand static seismic ‘g’ loads and/or response spectrum 
loads, “integral 2-way vertical and lateral restraints” are required. Generally, some of the vertical weight 
supports can be modified as “integral 2-way vertical and lateral restraints”. On the other hand, for thermal 
loads, zero supports give zero stresses. So, thermal stresses and equipment nozzle loads will normally 
decrease as the number of supports goes down. Axial restraints and intermediate anchors are 
recommended only to direct thermal growth away from equipment nozzles.    

1.5 Recommended Procedure for checkSTRESS 

The steps given below may normally be followed using checkSTRESS to perform preliminary visual 
stress checks of piping systems designed using 3D plant design systems. 

Step1: Generating checkSTRESS model 

Apply checkSTRESS on the piping system under consideration in the 3D plant model, as outlined in the 
checkSTRESSPDMS / checkSTRESSPDS / checkSTRESSCADMATIC / checkSTRESSPCF Manual. 

In case some of the important inputs (such as Thermal Anchor Movements at equipment nozzles and 
Allowable Nozzle Loads) are not available in the 3D plant database/PCF file, they can be manually 
entered using the “Edit Layout” button provided in checkSTRESS. 

Step2: Studying Thermal Stress results for the Initial Layout 

Review first stress contour plot for thermal stresses. The plot is color-coded such that “blue” region 
denotes areas with the least stress ratios (where stress ratio equals to actual computed stress divided by 
allowable thermal stress), “green” region with higher stress ratios, “yellow” region with even higher stress 
ratios, and “red” region with the highest stress ratios. Intermediate areas between these distinct colors will 
be of “bluish-green”, “greenish-yellow” and “orange” colors. 

Since thermal stresses generated are directly dependent on how “flexible” the layout is, it may be 
necessary to make the layout as “flexible” as possible (by including bends, offsets, loops etc.) to reduce 
thermal stresses. So, the Designer’s goal is to arrive at a “flexible” layout for which thermal stress ratios 
remain within “blue” to “yellow” range and not get into “orange” and “red” zones. For a more “flexible” 
layout, even “yellow” zone may be avoided. That would leave even more thermal margin for stress 
engineers to meet other pipe stress criteria not considered under checkSTRESS. 

Step 3: Finalizing Layout to meet Thermal Stress criteria 

In case thermal stress ratios exceed “yellow” zone (i.e., “orange” and “red” zones appear in one or more 
areas of the piping system), it is important to study the deformed shape for “thermal” load case in order to 
understand how the piping deforms for “pure thermal” load (where only temperature change is 
considered). By studying such deformed shape, it is possible to arrive at a layout with appropriate bends, 
offsets and loops and/or with appropriately located axial restraints/intermediate anchors such that thermal 
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stress ratios do not exceed “yellow” zone. This process may require the Designer to perform several 
iterations on layout and/or locations for axial restraints/intermediate anchors. 

Step 4: Studying Results for Sustained Load 

After finalizing piping layout under Steps 2 and 3 for thermal loading, the next task is to support the 
system vertically to carry its own deadweight under operating condition. In this connection, first review 
stress contour plot shown in color codes from “blue” to “red” (as in Step 2 above) for sustained stress 
ratios generated by deadweight and pressure for the system without any vertical supports (excepting 
those provided by equipment nozzles and intermediate anchors introduced in Step 3 above).  

The Designer’s goal is to arrive at a vertical support scheme consisting of (a) resting steel supports, (b) 
rod hangers, (c) variable spring hangers and (d) constant support hangers, at appropriate locations 
(where such pipe supports can be attached to adjacent concrete/steel structures, platforms etc.) so that 
stress contour plot for sustained stress ratios avoids “orange” and “red” zones and remains within “blue to 
yellow” range. 

Step 5: Finalizing Vertical Supports to carry Sustained Load 

In case sustained stresses exceed “yellow” zone in one or more areas of the piping system, study the 
deformed shape provided by checkSTRESS for sustained load case in order to understand how the 
piping responds to its own deadweight.  Next, identify pipe locations in the 3D model where the pipe can 
be vertically supported by the support types listed under Step 4 above. Based on this input, vertically 
support the piping such that sustained stresses do not exceed “yellow” zone. This step may require the 
Designer to execute checkSTRESS on the system with several different locations for weight supports. 

checkSTRESS automatically sizes variable spring hangers wherever such hangers were located in the 
3D model. 

In case resting steel supports are selected to provide vertical support for piping under sustained load, it is 
to be made sure that piping continues to rest on such steel supports even during operating condition (= 
weight + pressure + thermal) and does not lift off from these supports. If pipe lifts up at any of these 
resting supports during operating condition, then that support does not carry any pipe weight and hence 
will not serve its purpose. Similarly, at rod hanger locations, the tendency of piping should be to deform 
downward for operating load case, so that the rod hangers carry the pipe weight under tension. On the 
other hand, if pipe lifts up at any of the rod hangers, then that rod hanger goes into compression thereby 
not carrying the weight of the piping during operating condition. Whether the pipe weight is being carried 
during operation by resting steel supports and/or rod hangers (both types are mathematically modeled as 
one-way vertical Limit Stops in checkSTRESS) or whether the pipe lifts up at those support locations is 
shown in the report titled “Status of Limit Stops – Operating Load”. The goal is to make sure the status is 
shown as “Reached” at all vertical Limit Stops for Operating Load case.  

Step 6: Studying Results for Occasional Load(s) 

After arriving at a final layout with an acceptable pipe support scheme under Steps 2 to 5 for thermal and 
sustained loads, the next task is to protect piping against large horizontal and vertical movements that 
could occur due to static seismic “g” load and/or response spectrum load.  This can be accomplished by 
replacing some of the weight supports with “integral 2-way vertical and lateral restraints”. 

In this regard, review stress contour plot for occasional stresses generated by deadweight, pressure, 
static seismic “g” load and/or response spectrum load shown in color codes from “blue” to “red” (as in 
Step 2 above). 

The Designer’s goal is to replace some of the weight supports (for example, resting supports) located in 
the “yellow” to “red” zones with “integral 2-way vertical and lateral supports”, so that stress contour plot for 
occasional stresses avoids “orange” and “red” zones and remains within “blue to yellow” range. 

Step 7: Finalizing 2-way Vertical and Lateral Restraints to withstand Occasional Load(s) 

In case occasional stresses exceed “yellow” zone in one or more areas of the piping system, study the 
deformed shape provided by checkSTRESS for occasional load case(s) in order to understand how the 
piping responds to static seismic “g” load and/or response spectrum load. Next, identify those weight 
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support locations (for example, resting supports) in the “yellow” to “red” zones where the pipe can also be 
laterally supported and replace those weight supports with “integral 2-way vertical and lateral restraints”, 
such that occasional stresses do not exceed “yellow” zone. This step may require the Designer to 
execute checkSTRESS on the system with several different locations for “integral 2-way vertical and 
lateral restraints”.  

Step 8: Meeting Allowable Loads at Nozzles / Anchors 

After locating relevant supports (a) to minimize thermal stresses, (b) to carry weight of the piping during 
operation, and (c) to withstand static seismic “g” load and/or response spectrum load, the Designer 
should check the calculated loads at nozzles/anchors in the Support Load Summary. If the calculated 
loads at nozzles/anchors exceed the corresponding Allowable Loads, by studying the deformed shapes 
provided by checkSTRESS for different load cases, it is possible to further modify the layout and/or 
support scheme such that the calculated loads at nozzles/anchors do not exceed the Allowable Loads. 

As a minimum, the above said Nozzle Load compliance should be carried out for Operating Load case. 

Any such changes made to the layout and/or support scheme at this stage (i.e., at Step 8) should not 
adversely affect the stresses for thermal, sustained and occasional load cases (i.e. all the 3 stress 
contour plots should continue to avoid “orange” and “red” zones and remain within “blue to yellow” range). 

This process may require the Designer to perform several iterations on layout and/or support scheme. 

Step 9: Key Results to confirm Validity of Layout with finalized Support Scheme 

Designers are to perform Step 1 to Step 8 for all relevant piping systems of the project.  

Once the layout and support scheme are finalized for a system, the Designer confirms the validity of that 
design by submitting key results generated by checkSTRESS as listed below. 

a) Ten (10) highest stress ratios and their locations,  

b) Equipment nozzle load compliance with allowable loads,  

c) Report listing spring sizes, hot loads, cold loads and travel for variable spring hangers sized by 
checkSTRESS, 

d) Status of Piping at resting supports during operation (i.e., is the pipe resting on or lifting off a 
resting support?), 

e) Bill of Materials, 

f) Weight and Center of Gravity, 

g) Table of Contents, and 

h) Relevant stress contour plots and deflected shapes. 

Step 10: Export checkSTRESS models to Pipe Stress Software input files 

Piping systems, for which the layout and support schemes are finalized, can then be translated into stress 
input files of the pipe stress software currently covered under the checkSTRESS modules (see 
Subsection 1.2 above).  Pipe stress engineers can then imports these stress input files into their pipe 
stress software and perform detailed analyses and stress report preparation. This eliminates (a) 
generation of “stress isometric drawings” and (b) re-inputting the data into the pipe stress software.  

Pipe stress engineers should check the stress models so sent by Designers and add (wherever required) 
additional input data into the models such as insulation thickness and density, corrosion allowance and 
mill tolerance of pipe sections, thermal anchor movements, seismic anchor movements, support 
conditions such as friction and gap, other occasional loads such as wind and water/steam/fluid hammer, 
multiple thermal and pressure cases, etc. and perform detailed analyses.  

It is most likely that the layout with the support scheme finalized by Designers using checkSTRESS 
should be able to meet all other pipe stress criteria (for examples, stress compliance for other thermal 
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ranges and occasional loads, leakage checks at flanges, qualification of lug attachments welded to pipes 
etc.), thereby substantially reducing the number of iterations between stress and layout departments. 

This manual describes the operational details of checkSTRESS. It is assumed that the user is already 
familiar with the principles of Plant Design Software Piping Application and the practices followed in Plant 
Design Piping catalogue and specifications, and the user has used Plant Design Software to generate the 
piping by using available facilities in Plant Design Software.  

The working sequence of the software is listed below. 

1. The pipe branches modeled in the Plant Design Software are read and passed onto 
checkSTRESS.  

2. checkSTRESS then, from the material mapping database (see Note 1) provided with 
checkSTRESS, identifies valid materials (which will be used for first level pipe stress calculations 
within checkSTRESS) that would correspond to the material specifications given for those 
branches in the Plant Design Software. This executable finally carries out stress analysis and 
displays contour plots of Stress ratios for Sustained and Expansion cases. It also plots graphically 
the deflected shapes for Sustained, Expansion and Operating load cases.  

3. Finally, this software has a provision to write CAEPIPE 7.xx mod file, which is used for carrying 
out detailed stress analysis and stress report preparation using CAEPIPE. See Note 2 below. 

The sequence of checkSTRESS operation is shown diagrammatically in Figure 1-1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.1 

 

Note 1: Refer Appendix B and Appendix D for more details. 
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2.0 Installing the Program 

Refer Section 1 in SST License Manager User’s Manual for details. 

3.0 Limitations 

Limitations defined in this Chapter are generic in nature and is not specific to any Plant Design application 
software. Limitations specific to each Plant Design application is listed in the corresponding Readme file 
(*.pdf) supplied along with the checkSTRESS software for that Plant Design application. 

The present version of the checkSTRESS has the following limitations. 

3.1 In Case of unavailability of checkSTRESS material detail corresponding to Plant Design material 
description (available in the neutral file), then program takes the Material information specified in the 
first row of the material Mapping DB selected during transfer to checkSTRESS. Refer Appendix B for 
more details. User can also modify the Material properties in checkSTRESS through Edit Layout-
>Misc->Materials. 

3.2 If OD (outer diameter) or Thickness (Wall thickness) for an element is not available in the neutral file, 
then OD and Thickness shall be extracted from the Mapping DB corresponding to the specified 
Nominal Size for that element.  

Note: Thickness corresponding to Standard Schedule (ANSI) is entered in the Mapping DB and 
supplied with the standard product. User can change these values to suit their project requirement, if 
necessary. Refer Appendix C for more details. 

In addition to the above, user can modify the OD and Thickness of a component through Edit Layout-
>Misc->Sections. 

3.3 The following items are currently not transferred from Plant Design to checkSTRESS at this time. 
However, user can add these items in checkSTRESS through Edit Layout->Misc->Sections. 

a. Corrosion allowance and Mill tolerance of the piping section and 

b. Lining Density and Lining Thickness of the piping section. 

Note:  

As checkSTRESS is nothing but the simplified version of CAEPIPE, the details on editing the layout and 
adding Response Spectra loads can be referred from CAEPIPE User’s Manual. This document can be 
downloaded from http://www.sstusa.com. 

 

http://www.sstusa.com/
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4.0 Reference 

This section describes in detail, the methodology followed for transferring the piping components from 
Plant Design software to checkSTRESS. 

4.1 Loads 

Temperature (Deg F or Deg C) and Pressure (psi or kg/cm2) entered in 3D Plant Design software is 
transferred to checkSTRESS for all the elements. If the specific gravity of the fluid (with respect to water) 
is specified during run time, the same will be transferred to checkSTRESS. If left blank then it will be set 
as 0.0. 

4.2 Pipe 

Pipe from 3D Plant Design software is transferred as Pipe to checkSTRESS. OD and Thickness (in or 
mm) is read from the Plant Design Database and transferred to checkSTRESS for each element. If OD 
and/or Thickness are not available / entered in the 3D Plant Design software, then the program will read 
the OD and / or Thickness from the Mapping DB corresponding to the Nominal Size specified in the 3D 
Plant Design for that element. Material name for each pipe element is read from the 3D Plant Design 
Database the program then gets the material properties corresponding to the 3D Plant Design material 
name through the Mapping DB and writes the same to checkSTRESS for that element. 

4.3 Bend / Elbow 

Bend/Elbow from 3D Plant Design software is transferred as “Bend” to checkSTRESS. The radius (in or 
mm) of the bend is extracted from the database, if available otherwise; it is calculated as the distance 

between the Near/Far end of the bend and Tangent Intersection Point divided by Tan ( /2), Where   is 

the included angle of the bend. The value thus obtained above shall be written to bend radius field in 
checkSTRESS. 

4.4 Valve 

Valve from 3D Plant Design software is transferred as “Valve” to checkSTRESS. Dry weight of valve 
(without Fluid weight [lb or kg]) is read from 3D Plant Design Database and transferred to “Weight” field of 
checkSTRESS Valve element.  

4.5 Reducer 

Reducer (Concentric and Eccentric) from 3D Plant Design software is transferred as Reducer to 
checkSTRESS. The OD (in or mm) and Thickness (in or mm) obtained from the Arrive position shall be 
written to “OD1” and “THK1” fields of checkSTRESS. On the other hand, the OD and Thickness obtained 
from the Leave position shall be transferred to “OD2” and “THK2” fields in checkSTRESS.  

4.6 Instrument 

Instruments from 3D Plant Design software are transferred as “Rigid” element to checkSTRESS. Dry 
weight (lb or kg) of Instrument is read from 3D Plant Design database and the same is transferred to 
“Weight” field of the rigid element in checkSTRESS.  

4.7 Flange 

Flange from 3D Plant Design software can be transferred as “Pipe with Flange” or “Rigid element” to 
checkSTRESS. If the user selects “Pipe with Flange” option from checkSTRESS dialog during run-time, 
then the program creates a pipe for a length equivalent to length of flange and creates a Flange node at 
the pipe end in checkSTRESS with flange type as “Weld Neck”. The OD and Thickness (in or mm) 
corresponding to Flange Nominal Size is transferred to pipe in checkSTRESS. Dry weight of flange is 
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read from 3D Plant Design database and the same is transferred to “Weight” field of the Flange Data 
Type in checkSTRESS 

On the other hand, If the user selects “Rigid element” option during run-time then, the program will 
transfer the same as “Rigid Element” to checkSTRESS. Dry weight of flange is read from 3D Plant Design 
database and the same is transferred to “Weight” field of the Rigid Element in checkSTRESS.  

4.8 Olet 

Olet from 3D Plant Design software is transferred as Pipe to checkSTRESS with a Branch SIF defined at 
the intersection (i.e., where the branch pipe intersect the main run of the pipe).  

4.9 Tee 

Tee from 3D Plant Design software is transferred as three pipes connecting the near end & center, far 
end & center and branch point & center with a Branch SIF (Welding Tee) specified at the center point of 
the Tee. OD and Thickness read from the 3D Pant Design database for this component is transferred to 
each checkSTRESS pipe fields thus created as mentioned above. 

4.10 Three Way Valve 

Three Way Valve from 3D Plant Design is transferred as “Three Rigid Elements” or “Three Pipes with one 
Concentrated Mass at its Centre” to checkSTRESS by connecting the near end & center, far end & center 
and branch end & center. From the section property, weight of fluid (kg/lb) is calculated and is added to 
the dry weight (kg/lb) of Three Way valve read from 3D Plant Design database. The total weight thus 
obtained is transferred to each rigid element in proportion to its length.  

In the latter option, the dry weight of Three Way valve is transferred as weight of the Concentrated Mass 
at the intersection of the three pipes. 

4.11 Cross 

Cross from 3D Plant Design software is transferred as four pipes connecting near end & center, far end & 
center and two branch points & center with Branch SIF (Welding Tee) at the pipes intersection in 
checkSTRESS. OD and Thickness read from the 3D Pant Design database for this component are 
transferred to each pipe fields thus created as mentioned above. 

4.12 Four way Valve 

Four Way Valve from 3D Plant Design is transferred as “Four Rigid Elements” or “Four Pipes with one 
Concentrated Mass at its Centre” to checkSTRESS by connecting the near end & center, far end & center 
and two branch ends & center. From the section property, weight of fluid (kg/lb) is calculated and is added 
to the dry weight (kg/lb) of Four Way valve read from 3D Plant Design database. The total weight thus 
obtained is transferred to each rigid element in proportion to its length.  

In the latter option, the dry weight of Four Way valve is transferred as weight of the Concentrated Mass at 
the intersection of the three pipes. 

4.13 Material 

Material name from Plant Design software is mapped to get the corresponding checkSTRESS material 
and then transferred to checkSTRESS.  Refer Appendix B for details. 

User can also add/modify the Material properties in checkSTRESS through Edit Layout > Misc >Materials. 
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4.14 Support 

Support information (Location and its type) from Plant Design software can be transferred to 
checkSTRESS in two ways viz.  

a. With the use of mapping DB and 

b. Without using Mapping DB  

Refer Appendix D for details. 

4.15 Thermal Anchor Movement (TAM) 

Thermal Anchor Movement (TAM) values entered in global X, Y and Z directions at Equipment Nozzle 
where the piping layout (selected for checkSTRESS) is connecting to. These values thus entered can be 
transferred to checkSTRESS. TAM values should be defined in “mm” for SI units and in “Inch” for English 
units. If the TAM values are not available / entered in 3D Plant Design software at Equipment Nozzle then 
they can be entered into checkSTRESS through Edit Layout option. i.e., Click Edit Layout then select 
“Anchor” and select “Edit data” through Layout > Edit. From the dialog box shown, click on “Specified 
Displacement” and enter the TAM values. 

4.16 User defined Equipment Nozzle Allowable Loads 

Equipment Nozzle Allowable Loads (forces and moments) provided by the equipment manufacturer or 
calculated using Applicable codes / Finite Element Methods can be entered in global X, Y and Z 
directions at Equipment Nozzle where the piping layout is connecting to. These values thus entered at the 
Equipment Nozzle of the 3D Plant Design software can be transferred to checkSTRESS. Please note, the 
force values should be entered in “lb” for English units and in “N” for SI units. Similarly, the moment 
values should be entered in “ft-lb” for English units and in “Nm” for SI units. 

If allowable loads values are not entered / available in the 3D Plant Design software, then these values 
can also be entered through Edit Layout > Misc > User Allowables. The allowables thus defined are 
compared against calculated loads and shown / printed in Support Load Summary outputs (can be 
viewed / printed through “Show Summary” option). If the calculated loads exceed the allowables, they are 
highlighted in red.  

4.17 Units 

This section describes the units of measurement used to transfer the information from 3D Plant Design 
software to checkSTRESS. 

Length (Inches or mm) 

Length related dimensions such as OD, Wall thickness, Insulation thickness, Bend radius and Nominal 
Size from 3D Plant Design software are transferred as Inches or mm for English and SI units respectively. 

Temperature (Deg F or Deg C) 

Temperature from Plant Design software is transferred as Deg F or Deg C for English / SI units 
respectively. 

Pressure (entered as psi or kg/cm2 in Plant Design) 

Pressure from Plant Design software is transferred as psi or bar for English / SI units respectively. 

Mass or Weight (lb or Kg) 

Dry weight and Wet weight of components from Plant Design software are transferred as lb or Kg for 
English and SI Units respectively.  
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Density (lb/in3 or kg/m3) 

Material Density, Insulation Density and Fluid Density from Plant Design software are transferred as lb/in3 
or Kg/m3 for English and SI units respectively. 

Translational Stiffness (lb/in or N/mm) 

Translational stiffness from Plant Design software is transferred as lb/in or N/mm for English and SI Units 
respectively to checkSTRESS. 

Rotational Stiffness (in-lb/deg or N-m/deg) 

Rotational Stiffness from Plant Design software is transferred as lb-in/deg or N-m/deg for English and SI 
Units respectively to checkSTRESS. 

Force (lb or N) 

Force values from Plant Design software is transferred as lb or N for English and SI Units respectively to 
checkSTRESS. 

Moment (ft-lb or Nm) 

Moment values from Plant Design software is transferred as ft-lb or Nm for English and SI Units 
respectively to checkSTRESS. 
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Appendix A 

3D Plant Design–to–checkSTRESS Component Mapping 

All components available in Plant Design software are mapped with checkSTRESS component. The 
details are tabulated below. 

Type of Component in 
Plant Design software 

Type of Component in checkSTRESS Keywords used in 
Neutral File 

Pipe Pipe PI 

Valve Valve VA 

Flange Rigid Element  / Pipe with Flange FL 

Instrument Rigid Element RB 

Reducer Concentric Reducer Concentric RD 

Reducer Eccentric Reducer Eccentric ER 

Cross Four Pipes with Branch SIF (Welding 
Tee) 

CR 

Elbow / Bend Bend EL 

Three way Valve Three Rigid Elements / Three Pipes with 
Concentrated Mass 

3W 

Four way Valve Four Rigid Elements / Four Pipes with 
Concentrated Mass 

4W 

Tee Three Pipes with Branch SIF (Welding 
Tee) 

TW 

Olet Pipe with Branch SIF (Weldolet) TO 

Support Restraint Data Type(s) HA 

Hanger Hanger Data Type HA 

 

Note: Refer Plant Design software specific Readme file (.hlp) supplied with the product for detailed 
component mapping. 
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Appendix B 

Material 

Material name for each element is read from the 3D Plant Design database and is written to the neutral 
file. The program then gets the checkSTRESS material information corresponding to 3D Plant Design 
material information as follows. 

a. checkSTRESS reads the Material Mapping DB file name from the table “code” available in 
Codedb.mdb corresponding to the Analysis Code specified in the form during transfer. 

b. Gets the checkSTRESS Material properties from the Material Mapping DB (thus obtained above) 
corresponding to 3D Plant Design material description. 

In case of unavailability of checkSTRESS material property corresponding to 3D Plant Design material 
description available in the transfer file, then program reads the checkSTRESS Material property 
specified in the first row of the Material Mapping DB (obtained above) and transfers the same to 
checkSTRESS. 

Material DB Modification / Creation 

User is allowed to create their own material table and can use the same by modifying/adding the name of   
Material Mapping DB file name in table “code” of “Codedb.mdb” supplied along with this software. This 
table contains four fields viz. PdCode, KpCode, KpMat and KpSect. The first field “PdCode” contains the 
name of Piping Codes that can be specified in 3D Plant Design Software. The second field “KpCode” 
contains the name of Piping Codes that are available in checkSTRESS corresponding to Analysis Code 
defined in 3D Plant Design Software. Third field “KpMat” defines the name of the Material DB file to be 
used (to get the CAEPIPE Material property) during transfer. Fourth field “KpSect” defines the name of 
the Schedule Table to be used (to extract OD and Thickness if not available in the Neutral file for an 
element) during transfer. Please note, the Material DB must exist before it is used in the Codedb.mdb. 
The procedure for creating a Material DB and modifying the Codedb.mdb is listed below. 

a. Copy the existing file (B311.mdb) and rename the file with a desired name by pasting it to the 
directory where the source file was stored. 

b. The newly created DB contains four tables viz. MaterialE, MaterialS, MdetailE and MdetailS. The 
MaterialE and MdetailE table in the DB are used to define material properties in English units 
whereas MaterialS and MdetailS tables are used to define the material properties in Metric units. 

c. Enter the Plant Design Material description (available in 3D Plant Design Database) into the field 
“MatName” of “MaterialE/MaterialS” table and enter the engineering property of the material such 
as Density, Nu, Joint factor, etc., depending upon the availability of the information in the code 
selected and leave the rest of the fields as “None”. For example, the fields Tensile, CircFactor 
and Yield is not valid for B31.1 and hence it should left as “None”. 

d. Enter the Temperature related property such as Young’s Modulus, Alpha, Allowable, etc., into 
“MDetailE/MdetaiS” table by expanding it using the button “+”. Fill the fields that are relevant to 
the Material Code selected and leave the rest as “None”. 

e. Modify the contents of each table with new values and save the DB. Fill the table fields with the 
appropriate values available depending upon the type of piping code. Other fields can be left as 
“None”.  

f. After successful creation of material Mapping DB as explained above in steps a to e, open the DB 
codedb.mdb and enter the name of the Material DB file thus created above in the field “KpMat”. 
For example, if you have created your own material Mapping DB file corresponding to B31.5 as 
B315.mdb, then enter the name of the file (B315.mdb) in the field “KpMat” as “B315” where the 
value of the field “PdCode” is equal to B31.5 and then enter the corresponding checkSTRESS 
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Section details table name in the field “KpSect”. A sample “Code” mapping DB with Material DB is 
given below for reference.  

Sample “Code” DB 

 

Fields in Code DB Table: 

PdCode - Name of the Piping Code than can be specified in Plant Design Software.  

KpCode - Analysis code corresponding to Plant Design Code. 

KpMat - Material DB name from where the material details are specified. 

KpSect - Section DB name from where the Schedule details are specified. 
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Sample “Material DB” (B315.mdb) 

Sample Table “MaterialE” for English Units 

 

Sample Table “MdetailE” for English Units 

Fields in each table and their descriptions are given below in detail. 

Fields in MaterialE Table: 

Index   - Unique Material Id 

MatName  - Material Name 

Density  - Density of the Material in English units 

Nu   - Poisson Ratio 

JointFactor  - Joint Factor of the Material 

MaterialType - Type of Material 

Tensile  - Tensile Strength 

CircFactor  - Circular Factor 

Yield  - Yield Strength 
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Sample Table “MaterialE” for English Units 

 

 Fields in MDetailE Table: 

MatName  - Material name 

Temperature - Material Temperature  

E   - Young’s Modulus 

Alpha  - Alpha value for material 

Allowable  - Allowable Loads 

Yield  - Yield Strength 

Rupture  - Rupture Stress 

Design  - Design Factor 

Proof  - Proof Stress 

fh   - Allowable Stress at Maximum Temperature 

fCR   - Allowable Creep Stress 

Material properties for six piping codes viz B31.1, B31.3, B31.4, B31.5, B31.8 and EN13480 are available 
in the DB (i.e. B311.mdb and B313.mdb).  
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Modification of “Config.ini” File 

Material Mapping DB’s and Support Mapping DB’s are stored in the Application directory of the Product. 
The customized Material Mapping DB’s and Support Mapping DB’s can be shared among the users of the 
product by copying these files in a shared location and modifying the “config.ini” file to point to the new 
path. 

For clarity, “config.ini” file contains the path of the Material Mapping DB’s and Support Mapping DB’s. By 
default, this will point to the application directory. Copying these files to a shared location and modifying 
the path in the “config.ini” to reflect the new location will help users to share the customized DB’s. The 
content of the file is listed below for reference. 

[Config] 

Product Name=checkSTRESS 

Product Type=Server Version 

Materials_DB= 

Code_DB= 

Support_DB= 

leaving the above fields empty will use the default path 

Assuming the Material Mapping DB’s, Code DB and Support DB are stored in the shared location DBS of 
machine “InfoP025”, modify the Materials_DB, Code_DB and Support_DB as follows. 

[Config] 

Product Name=checkSTRESS 

Product Type=Server Version 

Materials_DB=\\InfoP025\DBS 

Code_DB=\\InfoP025\DBS 

Support_DB=\\InfoP025\DBS 

leaving the above fields empty will use the default path 

Warning: Care should be taken while entering the fields of the CodeDb.mdb and the Material 
Mapping DB as the wrong entry or leaving the field empty may lead to malfunction of the software.  
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Appendix C 

Schedule Table 

The table “code” in Codedb.mdb contains a field named “KpSect” to specify the schedule to be used 
during transfer. In case of unavailability of OD and/or thickness values in transfer file, translator reads the 
OD and/or thickness from the standard schedule table and transfers the same to checkSTRESS. In case 
the value of the field “KpSect” is not defined or left empty in the table, then the program will use the 
“Standard Schedule (STD)” for ANSI standard by default. 

Schedule Table Creation / Modification 

The procedure for creating the user defined Standard Schedule Table is listed below 

1. Copy the table “STDsch” and then paste it as new table in the same “Codedb.mdb” by specifying 
a new name for the table. 

2. Modify the contents of the table with the new values. 

3. Open the table “Code” and then enter the “KpSect” field with the name of the table created above 
corresponding to the “PdCode”. For e.g. assuming the name of the new Standard Schedule table 
created as “Sch40” corresponding to “B31.1” PdCode, change the value of field “STDsch” as 
“Sch40”. 

 

Sample Schedule Table 

 

Fields in standard schedule table and their descriptions are given below in detail. 

NPD_E  - Nominal Piping Diameter in Inches 

NPD_M  - Nominal Piping Diameter in Millimeters 

OD   - Outside Diameter in mm 

THK   - Wall thickness in mm 

 

Warning: Care should be taken while filling the fields of the Schedule DB as the wrong entry 
may lead to malfunction of the software. 
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Appendix D 

Supports 

Support information (Location and its type) from Plant Design software can be transferred to 
checkSTRESS in two ways viz.  

1. With the use of mapping DB 

2. Without using Mapping DB 

With the use of mapping DB 

The support details (entered via attributes) and its location specified in the Plant Design software are 
transferred to checkSTRESS. The values of the attributes filled at support locations shall be in 
accordance with the values specified in the field #1 of tables “Zvertical” and “Yvertical” of 
“SupportType.mdb” built into the application. The values from field #1 of table “Zvertical” shall be referred 
and entered at the support locations (via attributes), if the Global Vertical Axis to be used in the Stress 
Model is “Z”. On the other hand, values from field #1 of table “Yvertical” shall be referred and entered at 
the support locations (via attributes), if the Global Vertical Axis to be used in the Stress Model is “Y”.  

Fortunately, the values entered/available in the field #1 of tables “Zvertical” and “Yvertical” are kept 
identical, because most Plant Design software always consider the vertical direction as Z-axis.  On the 
other hand, pipe stress engineers in different parts of the world use either Z-axis as vertical or Y-axis as 
Vertical. So, the values entered in the field “KpSupport” are different for “Zvertical” and “Yvertical”. 
Program always uses the value entered in the field “KpSupport” corresponding to the value entered in 
field “PdSupport”, for its stress model file generations. 

User can modify the values available in the field “PdSupport” of tables “Zvertical” and “Yvertical” to suit 
their requirements. It is recommended to keep the values entered in the filed “PDSupport” of tables 
“Zvertical” and “Yvertical” identical as much as possible. This will help to avoid the user in 
reentering/changing the values at support locations for different Global Vertical Axis.  

In case, the CAEPIPE support information corresponding to the attribute value entered in the Plant 
Design is not available/defined in the mapping DB, then the translator skips that support at the location. 

Without using Mapping DB 

In smaller organizations, the Plant Design Engineer would be responsible for carrying out the Stress 
Analysis and hence, he would be familiar with the usage of checkSTRESS software and the customs 
followed in generating the Stress Models. He also would be familiar in arriving at the mathematical model 
equivalent to the geometric model from Plant Design Software. i.e., can define the support conditions 
(boundary conditions) in checkSTRESS equivalent to the Physical Support configurations from Plant 
Design software. In such cases, the Plant Design Engineer can transfer the support details (locations and 
types) by entering them at the support locations directly and transfer the same to checkSTRESS without 
using the mapping DB. Refer the sections listed below for details. 

Transfer of Supports 

The support details (entered via attributes) and their locations specified in the Plant Design software are 
transferred to checkSTRESS. Refer .hlp file for details on attributes to be filled. The values of the 
attributes that can be filled at support locations shall be in the format as listed below. 

Hangers 

Hangers can be transferred from 3D Plant Design software to checkSTRESS by specifying the following 
at support locations. 
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Syntax:  

Hanger(Type of Hanger:Number of Hangers:Allowable Travel Limit[in or mm]:Load Variation[%]:Short 
Range) 

Example:  

Hanger(Grinell:2: :20:1) 

Note: Allowable Travel Limit option is not enabled at this time. Please skip that field while entering the 
values. 

Rod Hanger 

Rod Hangers can also be transferred from 3D Plant Design software to checkSTRESS by specifying the 
following at support locations. 

Syntax:  

Hanger(ROD:Number of Hangers) 

Example:  

Hanger(ROD:1) 

Constant Support 

Constant Support can be transferred from 3D Plant Design software to checkSTRESS by specifying the 
following at support locations. 

Syntax:  

Hanger(CONSTSUPPORT:Number of Hangers) 

Example:  

Hanger(CONSTSUPPORT:3) 

User Hanger 

User specified Hangers could also be transferred from 3D Plant Design software to checkSTRESS by 
specifying the following at support locations. 

Syntax:  

USERHANGER(Number of Hangers:Spring Rate[ib/in or N/m]:Cold Load:Hot Load) 

Example:  

For example one number of user hanger with spring rate of 1E8N/m, and hot load 1000 can be specified 
as follows, 

USERHANGER (1:1E8: :1000) 

Guide 

Guide Restraint can be transferred from 3D Plant Design software to checkSTRESS by specifying the 
following at support locations.  

Syntax:  

GUI(Stiffness[ib/in or N/mm]:Gap[in or mm]:Friction Coefficient) 

Example:  

Guide with Rigid stiffness, 50mm gap between guide and pipe and 0.3-friction coefficient can be specified 
as GUI(R:50:0.3) 
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Skewed Restraints 

Skewed restraint(s) with different directional vectors can be transferred from 3D Plant Design software to 
checkSTRESS by specifying vector details with the following at support locations.  

Syntax:  

SKEW(VecX:VecY:VecZ:Stiffness[ib/in or N/mm]:Gap[in or mm]:Friction Coefficient: Type) 

Type can defined as “R” (Rotational) or “T” (Translational) 

Example:  

SKEW(0.707:0.707:0.707:1E10: : :R) 

Note: Gap and Friction Coefficient options are not enabled at this time. Please leave those fields blank 
while entering the values. 

Skewed Restraints in Local Axes 

Skewed restraint(s) in Axial, Shear X and Shear Y can be transferred from 3D Plant Design software to 
checkSTRESS by specifying the following at support locations. For definition on Local Coordinates, refer 
to Section titled “Local Coordinates” in checkSTRESS Technical Reference Manual. 

Syntax:  

SKEWA(Stiffness[ib/in or N/mm]:Gap[in or mm]:Friction Coefficient:Type) – Skewed Restraint in Local 
Axial direction of element 

SKEWY(Stiffness[ib/in or N/mm]:Gap[in or mm]:Friction Coefficient:Type) – Skewed Restraint in Local 
Shear Y direction of element 

SKEWZ(Stiffness[ib/in or N/mm]:Gap[in or mm]:Friction Coefficient:Type)  – Skewed Restraint in Local 
Shear Z direction of element 

Type can defined as “R” (Rotational) or “T” (Translational) 

Example:  

SKEWA/SKEWY/SKEWZ(1E10::R) or SKEWA(Rigid::R) 

Double acting Translational Restraints 

Double acting Translational restraint(s) can be transferred from 3D Plant Design software to 
checkSTRESS by specifying the following at support locations.  

If Double acting Translational restraint(s) with both Stiffness and Gap are specified at a location, then the 
program will transfer the same as “Anchor” in that direction with Gap as equal to Anchor Displacement in 
that direction. Refer examples for details. 

If Double acting Translational restraints are specified with Stiffness and without Gap, then the program 
will transfer the same as “Anchor” in that direction with stiffness value as defined in the attribute. 

Lastly, if Double acting Translational restraints are specified without Stiffness and without Gap then the 
program will transfer the same as Restraint in that direction. 

Syntax:  

Translational Restraint Type(Stiffness[ib/in or N/mm]:Gap[in or mm) 

Example:  

X(1E6,10) will be Transferred as Anchor with X stiffness as “1E6” and Displacement in X as 10 mm. 

X(1E6);Y(1E6) will be transferred as Anchor with X and Y Translational stiffnesses as “1E6”. 

X;Y will be transferred as Restraint in X and Y (i.e., X and Y Restraints) 
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Double acting Rotational Restraints 

Double acting Rotational restraint(s) can be transferred from 3D Plant Design software to checkSTRESS 
by specifying the following at support locations.  

If Double acting Rotational restraint(s) with both Stiffness and Gap specified at a location, then the 
program will transfer the same as “Anchor” with flexible stiffness in that direction with Gap as equal to 
Anchor Rotational Displacement in that direction. Refer examples for details. 

If Double acting Rotational restraint(s) are specified with Stiffness and without Gap, then the program will 
transfer the same as “Anchor” with flexible stiffness in that rotational direction. 

Lastly, if Double acting rotational restraint(s) are specified without Stiffness and without Gap, then the 
program will transfer the same as Skewed Restraint with stiffness as “Rigid” in that direction. 

Syntax:  

Rotational Restraint Type(Stiffness[lb/in or N/mm]:Gap[in or mm]) 

Example:  

RX(1E6,10) will be Transferred as Anchor with RX stiffness as “1E6” and Displacement in XX as 10 mm. 

RX(1E6);RY(1E6) will be transferred as two Skewed Rotational Restraints one in X direction and other in 
Y direction with stiffness as “1E6”. 

RX;RY will be transferred as Skewed Rotational Restraints with Stiffness as “Rigid” in X and Y (i.e., X and 
Y Rotational Restraints) 

Double Acting Limit Stop 

Limit stop can be transferred from 3D Plant Design software to checkSTRESS by specifying the following 
at support locations. Directional components are must while specifying limit stop.  

Syntax:  

LIM(Stiffness[lb/in or N/mm]:Gap[in or mm]:Friction Coefficient:Xcomp:Ycomp:Zcomp) 

LIM(Stiffness[lb/in or N/mm]:Lower Gap/Upper Gap[in or mm]:Friction Coefficient:Xcomp:Ycomp:Zcomp) 

Example: 

1. Limit stop in Y direction with Rigid stiffness and equal lower and upper gap of 50 mm (i.e., lower limit 
= -50 mm and upper limit = 50 mm) with coefficient of friction 0.2 can be transferred by specifying the 
support attribute as LIM(RIGID:50:0.2:0:1:0).  

2. Limit stop in Y direction with Rigid stiffness and Lower gap of -50 mm and Upper Gap of 25 mm with 
coefficient of friction 0.2 can be transferred by specifying the support attribute as LIM(RIGID:-
50/20:0.2:0:1:0).  

Please note, Rigid stiffness means 1E+12 lb/in will be assigned internally in checkSTRESS software.  

Single / Double Limit Stop in Local Axes 

Limit stop in Local Axial, Shear Y and Shear Z directions can be transferred from 3D Plant Design 
software to checkSTRESS by specifying the following at support locations. For definition on Local 
Coordinates, refer to Section titled “Local Coordinates” in checkSTRESS Technical Reference Manual. 

Syntax:  

LIMA/LIMY/LIMZ(Stiffness[lb/in or N/mm]:Gap[in or mm]:Friction Coefficient] 

LIMA/LIMY/LIMZ(Stiffness[lb/in or N/mm]:Lower Gap/Upper Gap[in or mm]:Friction Coefficient] 

LIMA – Limit Stop in local Axial direction of element 
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LIMY– Limit Stop in local Shear Y direction of element 

LIMZ – Limit Stop in local Shear Z direction of element 

Example: 

Single Acting Local Limit Stops 

1. Single Acting Limit stop in Local Axial direction with Rigid stiffness and gap of 50 mm and coefficient 
of friction 0.2 can be transferred by specifying the support attribute as LIMA(RIGID:-50/None:0.2). 

2. Single Acting Limit stop in Local Axial direction with Rigid stiffness and gap of 0 mm and coefficient of 
friction 0.2 can be transferred by specifying the support attribute as LIMA(RIGID:0/None:0.2). 

Double Acting Local Limit Stops 

1. Double Acting Limit stop in Local Shear Y direction with stiffness of 1E+05 N/mm and equal lower and 
upper gap of 50 mm (lower limit = -50 mm and upper limit = 50 mm) and coefficient of friction 0.2 can 
be transferred by specifying the support attribute as LIMY(RIGID:50:0.2). 

2. Double Acting Limit stop in Local Shear Y direction with stiffness of 1E+08 N/mm and lower gap of 0 
mm, upper gap of 20 mm and coefficient of friction 0.2 can be transferred by specifying the support 
attribute as LIMA(RIGID:0/None:0.2). 

Please note, Rigid stiffness means 1E+12 lb/in will be assigned in checkSTRESS. 

Single acting Translational Restraints 

Single acting Translational Restraints are transferred as Limit Stop to checkSTRESS. If the user specifies 
single acting restraints with “+” and “-“ in the same axis (direction), then the program will transfer it as 
“Limit Stop” with direction of restraint as equal to axis positive direction and Gap specified in positive 
direction as “Lower Limit”  and Gap entered in negative axis direction as “Upper Limit:.  

If positive directional restraint is specified with Gap, then the program will transfer the same as Limit Stop 
with Gap value as “Lower Limit”. 

Similarly, if negative directional restraint is specified with Gap, then the program will transfer the same as 
Limit Stop with Gap value as “Upper Limit”. 

Refer the examples for details. 

Syntax:  

Single Acting Restraint Type(Stiffness[lb/in or N/mm]:Gap[in or mm]:Friction Coefficient) 

Example: 

+X(1e10:-15:0.25);-X(1e10:10:0.25) will be transferred as “Limit Stop” with Stiffness = 1E10, Lower Limit=-15 
mm, Upper limit=10 mm and Direction = 1,0,0. 

+Z(1E10:10) will be transferred as “Limit Stop” with Stiffness=1E10; UpperLimit=None, Lower Limit=10 and 
Direction=0,0,1. 

-Y(1E10:10) will be transferred as “Limit Stop” with stiffness=1E10; UpperLimit=10;Lower Limit=None and 
Direction=0,-1,0. 

Snubber 

Snubbers can be transferred from 3D Plant Design software to checkSTRESS by specifying the following 
at support locations.  



 

2255  

Syntax:  

Types of Snubber(Stiffness[lb/in or N/mm]) 

Example: 

YSNB(1E10) or ZSNB(1E6) 

Skewed Snubber 

Skewed Snubbers can be transferred from 3D Plant Design software to checkSTRESS by specifying the 
following at support locations.  

Syntax: 

SNB(VecX:VecY:VecZ:Stiffness[lb/in or N/mm]) 

Example: 

Skewed Snubber with stiffness 1E+9 can be specified with directional vectors as follows, 

SNB(0.707:0:0.707:1E9) 

Snubber in Local Axes 

Snubbers in Local Axial, Shear Y and Shear Z directions can be transferred from 3D Plant Design 
software to checkSTRESS by specifying the following at support locations. For definition on Local 
Coordinates, refer to Section titled “Local Coordinates” in checkSTRESS Technical Reference Manual. 

Syntax:  

SNBA(Stiffness[lb/in or N/mm]) – Snubber in Local Axial direction of element 

SNBY(Stiffness[lb/in or N/mm]) – Snubber in Shear Y direction of element 

SNBZ(Stiffness[lb/in or N/mm]) – Snubber in Shear Z direction of element 

Example: 

SNBA(1E10) or SNBY or SNBZ(R) 

Force / Moment 

Force and Moments can be transferred from Plant Design to checkSTRESS by specifying the following at 
support locations.  

Syntax: 

FORCE(Fx:Fy:Fz[lb or N]) 

MOMENT(Mx:My:Mz[lb-in or Nm]) 

Example: 

1000N Force acting in Y direction can be specified as follows 

FORCE(0:1000:0) 

500Nm Moment acting in Z direction can be specified as follows 

MOMENT(0:0:500) 

Threaded Joint 

Threaded Joint can be assigned to nodes by specifying the following at support locations. 

Syntax: 

TJOINT 



 

2266  

User SIF 

User SIF can be assigned for a node by specifying the following at support locations in Plant design 
software. 

Syntax: 

UserSIF(Value) 

Example: 

UserSIF(100) 
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Appendix E 

Possible Restraints Types and Hangers 

Particulars Syntax Example 

Anchor   

Anchor ANC(Stiffness:Gap) 
ANC or ANC(1E12:0.0) or 

ANC(1E12) 

Double Acting 
Translational Restraints 

 
 

X X(Stiffness:Gap) X or X(1E12) or X(1E12:25) 

Y Y(Stiffness:Gap) Y or X(1E10) or Y(R:50) 

Z Z(Stiffness:Gap) Z or Z(RIGID) or X(RIGID:35) 

Double Acting Rotational 
Restraints 

 
 

RX RX(Stiffness:Gap) RX or RX(1E12) or RX(1E12:0.0)  

RY RY(Stiffness:Gap) RY or RY(R) or RY(1E12:25)  

RZ RZ(Stiffness:Gap) RZ or RZ(RIGID) or RZ(R:50)  

Double Acting Snubbers  
 

XSNB XSNB(Stiffness) XSNB or XSNB(1E12)  

YSNB YSNB(Stiffness) YSNB or YSNB(R)  

ZSNB ZSNB(Stiffness) ZSNB or ZSNB(RIGID) 

Skewed Snubbers SNB(VecX:VecY:VecZ:Stiffness) 
SNB(0.707:0.0:0.707:1e12) or 

SNB(0:0:0.707:RIGID) 

Double Acting Snubbers 
in Local Axes* 

 
 

SNBA SNBA(Stiffness) SNBA or SNBA (1E12)  

SNBY SNBY(Stiffness) SNBY or SNBY(R)  

SNBZ SNBZ(Stiffness) SNBZ or SNBZ(RIGID) 

Single Acting 
Translational Restraints 

 
 

+X and -X 
Restraint Type(Stiffness:Gap:Friction 

Co-efficient) 
+X(1E10:35:0.35) or 

-X(RIGID:25) 

+Y and -Y 
Restraint Type(Stiffness:Gap:Friction 

Co-efficient) 
+Y(R:50:0.2) or 

-Y(:15:0.28) 

+Z and Z 
Restraint Type(Stiffness:Gap:Friction 

Co-efficient) 
+Z(:45) or –Z(RIGID::0.26) or 

+Z(:25) 
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Double Acting Limit 
Stops 

 
 

LIM 
LIM(Stiffness:Gap:Friction Co-
efficient:Xcomp:Ycomp:Zcomp) 

LIM(1E12:30::0:1:0) or 
LIM(RIGID:50:0.4:0.707:0.707:0) 

Single Acting Limit Stops 
in Local Axes* 

 
 

Axial  
LIMA(Stiffness:Lower Gap/Upper 
Gap:Friction Co-efficient) 

LIMA(1E12:30/NONE) or 
LIMA(RIGID:-50/NONE:0.3) 

Shear Y 
LIMY(Stiffness:Lower Gap/Upper 
Gap:Friction Co-efficient) 

LIMY(1E12:30/NONE) or 
LIMY(RIGID:-50/NONE:0.3) 

Shear Z 
LIMZ(Stiffness:Lower Gap/Upper 
Gap:Friction Co-efficient) 

LIMZ(1E12:30/NONE) or 
LIMZ(RIGID:-50/NONE:0.3) 

Double Acting Limit 
Stops in Local Axes* 

 
 

Axial  
LIMA(Stiffness:Gap:Friction Co-
efficient) or LIMA(Stiffness:Lower 
Gap/Upper Gap:Friction Co-efficient) 

LIMA(1E12:-30/50) or 
LIMA(RIGID:-50/20:0.3) or 
LIMA(R::0.2) [Lower Limit = 
Upper Limit  = 0.0] 

Shear Y 
LIMY(Stiffness:Gap:Friction Co-
efficient) or LIMY(Stiffness:Lower 
Gap/Upper Gap:Friction Co-efficient) 

LIMY(1E12:-20/30) or 
LIMY(RIGID:20:0.3) [Lower Limit 
= -20 and Upper Limit = 20] or 
LIMY(R::0.2) [Upper Limit = 
Upper Limit  = 0.0] 

Shear Z 
LIMZ(Stiffness:Gap:Friction Co-
efficient) or LIMZ(Stiffness:Lower 
Gap/Upper Gap:Friction Co-efficient) 

LIMZ(1E12:-20/30) or 
LIMZ(RIGID:20:0.3) [Lower Limit 
= -20 and Upper Limit = 20] or 
LIMZ(R:0/20:0.2) [Lower Limit = 
0.0 and Upper Limit  = 20] 

Double Acting Skewed 
Restraints 

 
 

Skewed Restraints 
Skew(VecX:VecY:VecZ:Stiffness:Gap: 
Friction coefficient:Type of Restraint) 

Skew(0.707:0.707:0.0:1E12: : :R) 

Double Acting Skewed 
Restraints in Local Axes* 

 
 

Axial  
SKEWA(Stiffness:Gap:Friction Co-
efficient:Type)  

SKEWA (1E12:::R)  or SKEWA 
(1E12:::T) 
R = Rotational Restraint 
T = Translational Restraint 

Shear Y 
SKEWY(Stiffness:Gap:Friction Co-
efficient:Type)  

SKEWY (1E12:::R)  or SKEWY 
(1E12:::T) 
R = Rotational Restraint 
T = Translational Restraint 

Shear Z 
SKEWZ(Stiffness:Gap:Friction Co-
efficient:Type)  

SKEWZ (1E12:::R)  or SKEWZ 
(RIGID:::T) 
R = Rotational Restraint 
T = Translational Restraint 
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Guide   

GUI 
GUI(Stiffness:Gap:Friction Co-

efficient) 
GUI or GUI(1E12) or GUI(R:50) 

or GUI(RIGID:25:0.25) 

Spring Hangers   

Hanger 
Hanger(Type:No.of Hangers:All.Travel 

Limit:Load Variation:Short Range) 

Hanger or Hanger(Grinnell :1) or 
Hanger(Grinnell :1: :25) or 
Hanger(Grinnell :1: :25:1) 

Constant Support Hanger 
Hanger(CONSTSUPPORT:No.of 

Hangers) 
Hanger(CONSTSUPPORT) or 
Hanger(CONSTSUPPORT:2) 

Rod Hanger Hanger(ROD:No. of Hangers) 
Hanger(ROD) or 
Hanger(ROD:1) 

User Hangers   

User Hangers 
UserHanger(Spring Rate:No.of 
Hangers: Cold Load:Hot Load) 

UserHanger(200:1:1131) or 
UserHanger(200:1:0.0:1088) 

Force / Moment   

Force Force(Fx:Fy:Fz) Force(1200:800:0.0) 

Moment Moment(Mx:My:Mz) Moment(0:500:250) 

Threaded Joint   

Threaded Joint TJOINT TJOINT 

User SIF   

User SIF UserSIF(Value) UserSIF(100) 

Weldolet**   

Weldolet OLET OLET 

* Valid and available for checkSTRESS, checkSTRESS II & checkSTRESS Nuke Version 9.40 or later, 
CAEPIPE & CAEPIPE 3D+ Version 10.50 or later, Plant Design to CAEPIPE version 9.30 or later. 

** Valid and available for checkSTRESS PCF, checkSTRESS II PCF & checkSTRESS Nuke PCF Version 
9.40 or later, CAEPIPE 3D+ for PCF Version 10.50 or later, AutoPlant to CAEPIPE, CATIA to CAEPIPE 
and PCF to CAEPIPE version 9.30 or later. 

Note: 

1. Stiffness, Gap and Friction Coefficient are optional values. If not defined, then it will be 
transferred as 1E12 lb/in i.e. RIGID, 0.0 in, and 0.0 respectively to CAEPIPE. 

2. For SI units, the Stiffness and Gap should be specified in N/mm and mm respectively. 

3. The Hanger Type, Number of hanger, Allowable Travel Limit (not applicable at this time), Load 
variation and Short range are optional value.  If the above information are not defined, then the 
program will assume the following  

a. Hanger Type = Hanger Type is selected/Specified in the checkSTRESS dialog box 
during transfer.  

b. Number of Hanger = 1 
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c. Allowable Travel Limit = 0.00 (not applicable at this time) 

d. Load Variation = 25 % 

e. Short range = 1 (Use short range) 

4. For SI units, the Spring Rate, Cold Load and Hot Load should be specified in N/mm, Kg and Kg 
respectively. 

5. For defining more than one support at each support location use “;” in between support 
definitions. Example, +X(1e12:0.25);-X(1e12:0.25). 

Hanger Types 

ABB-PBS Fee & Mason Nordon 

Basic Engineers Flexider (30-60-120) NPS Industries 

Berger-Paterson Flexider (50-100-200) Piping Services 

Bergen-Paterson (L) Fronek Piping Tech & Products 

BHEL Hyderabad Grinell Power Piping 

BHEL Trichy Hydra 
Sanwa Tekki(30-60-
120) 

Borrello Lisega Sanwa Tekki(85-170) 

Carpenter & Paterson Mitsubishi (30-60-120) Sarathi 

Comet Mitsubishi (80-160) Spring Supports 

Corner & Lada Myricks SSG 

Dynax NHK (30-60-120)  

Elcen NHK (80-160)  
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Appendix F 

Sample Problems and Solutions using checkSTRESS 

This Appendix provides a few sample layouts (specifically, Sample1, Sample 2, Sample 3 and Sample 5) 
to illustrate how bends, offsets, loops, axial restraints and/or intermediate anchors are used to reduce 
thermal stresses in piping (and resulting nozzle loads). 

Sample 4 and Sample 5 illustrate how piping can be supported by spring hangers and resting steel 
supports to comply with the code requirements for sustained loads. 

The CAEPIPE model files created using checkSTRESS for the sample problems listed in Appendix F are 
stored in the directory checkSTRESS_installation_path\Samples for reference. 

Sample: 1 (Loop_00 and Loop_01) 

This problem illustrates the use of expansion loops to reduce thermal stresses. 

A 8” NB Schedule 80 pipe (see Fig. 1A) connects two equipment at nodes 10 and 30 with an offset of 4’ 
(i.e., equal to distance between nodes 20 and 30). The pipe is of A53 Grade A carbon steel and is heated 
to 300 

0
 F.                                       

Pipe between nodes 10 and 20 grows thermally to the right towards node 20, while pipe between nodes 
30 and 20 grows up towards node 20, as illustrated in Fig. 1B. 

This thermal deformation generates large thermal stresses (orange and red zones) in the bend at node 
20 and at anchor node 30, as shown in Fig. 1C. 

Fig.1D shows a revised layout with a loop, introducing 2 additional bends at nodes 14 and 18, thereby 
making the layout more flexible. So, thermal growth of X-directional pipes between nodes 10 and 14 and 
then between 18 and 20 as well as the growth of Z-directional pipe between nodes 30 and 20 are 
absorbed by the 3 bends at nodes 14, 18 and 20. 

The corresponding stress contour plots for thermal and sustained load cases are shown in Fig.1E and 
Fig. 1F, confirming code compliance.  

 

Fig. 1A. Layout with Node Numbers 
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Fig. 1B Thermal Deformation Plot 

 

Fig. 1C Thermal Stress Contour Plot 
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Fig. 1D Revised Layout with Node Numbers 

 

Fig. 1E Thermal Stress Contour Plot 
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Fig. 1F Sustained Stress Contour Plot 
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Sample: 2 (IntermediateAnchor_00 and 01) 

This system shown in Fig. 2A is made of 3 pipe sizes, 4” NB Schedule 40 between the anchor node 10 
and the first reducer starting at node 50, 6” NB Schedule 40 between the first reducer and the second 
reducer ending at node 90, and 8” Schedule 40 between the nodes 90 and anchor node 130. The system 
temperature is 470

0 
F. 

Since the loop between nodes 10 and 40 is much more flexible (as it is made of 4” NB pipe) than the loop 
between nodes 100 and 130, the straight pipe between nodes 40 and 100 will thermally grow mostly 
towards the 4” NB loop, as shown in Fig. 2B, straining the pipe between nodes 10 and 40; this, in turn, 
produces large thermal stresses (i.e., orange and red zones) in the 4” NB loop and at anchor node 10, as 
observed in Fig. 2C. In other words, the thermal growth of pipe between nodes 40 and 100 is mostly 
absorbed by the 4” NB loop and very little by the 8” NB loop, defeating the very purpose of the 8” NB 
loop. 

In order to alleviate thermal stresses in the 4” NB loop, introduce an intermediate anchor at node 95 
immediately after the second reducer, so that the thermal growth of straight pipe from node 95 to node 
100 is absorbed by the 8” NB loop, while the thermal expansion of straight pipe between nodes 40 and 95 
is absorbed by the 4” NB loop, thereby making both loops achieve their intended purpose. The 
corresponding thermal displacement and thermal stress contour plots are given in Fig. 2D and Fig. 2E 
respectively. 

Fig. 2F confirms that for the deadweight of piping under operating condition, the present configuration 
with only two equipment nozzles at nodes 10 and 130 and an intermediate anchor at node 95 safely meet 
the code stress requirement for sustained load. 

 

 

Fig. 2A Layout with Node Numbers 
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Fig. 2B Thermal Deformation Plot  

 

Fig. 2C Thermal Stress Contour Plot 
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Fig. 2D Thermal Deformation Plot for Layout with Intermediate Anchor 

 

Fig. 2E Thermal Stress Contour Plot for Layout with Intermediate Anchor 
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Fig. 2F Sustained Stress Contour Plot for Layout with Intermediate Anchor 
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Sample: 3 (AxialSupport_00 and 01) 

This problem shows how axial restraints (i.e., supports that prevent movement in the pipe axial direction) 
can be effectively used to direct thermal growth towards expansion loops and to split thermal growth in a 
line such that the two piping portions grow in opposing directions. 

Fig. 3A shows the same problem as in Fig. 2D, with a 6” NB branch line added at the welding tee at node 
70 (i.e., from node 70 to node 240). 

The deformed geometry for thermal load is shown in Fig. 3B, where it is observed that the tee node 70 
does not move up in +Y-direction. Since the intermediate anchor at node 95 restraints the vertical riser 
(between bend node 220 and tee node 70) from thermally growing upward towards node 70, this riser 
grows downward producing large bending moments and stresses at and around equipment nozzle at 
node 240; in addition, since the upward growth of this vertical riser is effectively restrained at the tee node 
70 due to presence of intermediate anchor at node 95, large localized thermal stress is generated at the 
welding tee. This is observed in the thermal stress contour plot given in Fig. 3C. 

Fig. 3D shows the same piping system with the intermediate anchor replaced by two axial restraints; the 
axial restraint in the horizontal line at node 95 splits and directs its thermal growth towards the 4” NB and 
8” NB loops and does permit the horizontal line to move up in +Y-direction at tee node 70, whereas the 
axial restraint at node 210 splits the thermal growth of the vertical riser between nodes 220 and 70. From 
the thermal deformation plot given in Fig. 3E, it is observed that such that much less forces and moments 
and hence stresses would be generated at the equipment nozzle node 240 and welding tee node 70. Fig. 
3F and Fig 3G show the thermal stress and sustained stress (in this case sustained stress is due to only 
deadweight as pressure is zero) contour plots, confirming code compliant system for both loading cases. 

 

 

Fig. 3A Layout with Intermediate Anchor at Node 95 
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Fig. 3B Thermal Deformation Plot 

 

Fig. 3C Thermal Stress Contour Plot 
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Fig. 3D Layout with Axial Restraints at Node 95 and 210 

 

Fig. 3E Thermal Deformation Plot for Layout with Axial Restraints 
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Fig. 3F Thermal Stress Contour Plot for Layout with Axial Restraints 

 

Fig. 3G Sustained Stress Contour Plot for Layout with Axial Restraints 
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Sample: 4 (WeightSupports_00 and 01) 

This problem illustrates how to select and locate vertical supports to carry piping deadweight at operating 
condition. 

Fig. 4A shows a practical problem with 10” NB Standard schedule pipe from equipment nozzle at node 5 
upto the reducer starting at node 30, 8” NB Standard schedule pipe from this reducer to the pump nozzle 
at node 40, and a 6” NB Standard schedule branch line from the welding tee at node 25 to the equipment 
nozzle at node 125. 

The thermal stress contour plot given in Fig. 4B confirms that the piping system is highly flexible and 
hence meets the code requirement for thermal load. Fig. 4C shows the deflected shape for sustained load 
(i.e., mainly deadweight). It is observed that the weight of (i) the horizontal line from node 5 to node 15 
and (ii) a major portion of the vertical riser from node 15 to node 20 is carried by the equipment nozzle at 
node 5; on the other hand, the pump nozzle at node 40 carries the weight of (i) the horizontal line from 
node 20 to node 40, (ii) the valve portion of the branch line from node 25 to node 125 and (iii) a small 
portion of the vertical riser from node 15 to node 20. The deformation response for deadweight, in turn, 
generates large forces and moments and hence large sustained stresses at nozzle nodes 5 and 40 as 
shown in Fig. 4D for sustained stress contour plot. 

Fig. 4E shows the same layout with variable spring hangers attached at the bends at nodes 20 and 115, 
which carry piping deadweight and provide negligible restraint to thermal movement from cold to hot 
condition and vice versa. 

The thermal stress and sustained stress contour plots given in Fig. 4F and Fig. 4G confirm that the piping 
system with hangers is code complaint for both sustained and thermal load cases. 

 

 

Fig. 4A Layout with Node Numbers 



 

4444  

 

Fig. 4B Thermal Stress Contour Plot 

 

Fig 4C Sustained Load Deflected Shape 
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Fig. 4D Sustained Stress Contour Plot 

 

Fig. 4E Layout with Hangers 
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Fig. 4F Thermal Stress Contour Plot for Layout with Hangers 

 

Fig. 4G Sustained Stress Contour Plot for Layout with Hangers 
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Sample: 5 (Condensate_00, 01 and 02) 

This practical problem illustrates how to place resting steel supports to carry the weight of the system with 
operating fluid as well as to modify the layout in order to re-direct thermal growth to comply with code 
stress requirements.  

Fig.5A shows the initial layout where condensate from a tank is extracted by the pump suction lines. 
When one pump is operating, the other one is 100% standby. 

It is observed from the Fig. 5B that the pipeline from node 10 to node 100 thermally grows in the –Z 
direction, whereas the two pump suction lines, one from node 120 to node 180 and the other from node 
110 to node 250, thermally grow in the +Z direction. So, the straight pipe between nodes 100 and 120 
(with a welding tee at node 110) experiences two opposing deflection patterns. The pipe portion between 
nodes 110 and 120 is being deflected in the +Z direction like a rigid stick; on the other hand, the portion 
between nodes 100 and 110 is being bent at tee node 110 as the node 100 deflects in –Z direction. This 
deflection response, in turn, produces high strains and thermal stresses locally at the tee node 110, as 
shown in Fig. 5C. 

In order to reduce the high local thermal stresses at node 110, we cut the straight pipe between nodes 
100 and 120 into two parts; one part is the pipe from node 100 to node 110 and the second part is from 
node 110 to node 120. We then shifted the second part downstream towards the two pumps, resulting in 
the modified layout shown in Fig. 5D. Fortunately, this shift of pipe downstream would not adversely 
increase the pressure drop between the tank at node 10 and the pumps at nodes 180 and 250.  

From the thermal deformation plot for this revised layout shown in Fig. 5E, it is observed that the two 
pump suction lines from the suction nozzles to the welding tee at node 111 have almost equal thermal 
growth in the +Z direction, thereby moving the branch pipe between nodes 111 and 300 as a rigid stick 
resulting in low thermal stresses in that branch pipe as seen in Fig. 5F. In addition, it is observed that the 
pump suction lines from the bend node 100 to the pump suction nozzles thermally grow in the +Z 
direction, whereas the pipe from the tank node 10 to the bend node 90 grow in the –Z direction; this 
opposing deflections rotate the inter connecting pipe between nodes 90 and 100 like a “see-saw” in the 
horizontal XZ plane, resulting in low thermal stresses in this region, as observed in Fig. 5F. 

Although the thermal stress criteria have been met, the weight stresses exceed the sustained stress 
allowable, as illustrated by many red and orange areas in the sustained stress contour plot given in Fig 
5G. This is because there are no vertical supports (excluding the 3 nozzles and a variable spring hanger 
at node 52) to carry the weight of the system.  

Now, vertical resting supports are introduced as shown in Fig.5H and the corresponding sustained stress 
(i.e., weight + pressure) contour plot (with most areas in blue) shown in Fig.5I confirms that the sustained 
stresses are well below the allowable values. 
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Fig. 5A Layout with Node Numbers 

 

Fig. 5B Thermal Deformation Plot 



 

4499  

 

Fig. 5C Thermal Stress Contour Plot 

 

Fig. 5D Revised Layout with Node Numbers 
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Fig. 5E Thermal Deformation Plot for Revised Layout 

 

Fig. 5F Thermal Stress Contour Plot for Revised Layout 
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Fig. 5G Sustained Stress Contour Plot for Revised Layout 

 

Fig. 5H Revised Layout with Resting Supports 
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Fig. 5I Sustained Stress Contour Plot for Revised Layout with Resting Supports 
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Appendix G 

Errors and Descriptions 

This Appendix presents the list of errors, their descriptions and the necessary actions to be taken. 

1. "Invalid Entry. Starting Node number should be a Numeric value." 

Starting Node number specified is not a numeric value. Please enter only numeric value. 

2. "Invalid Entry. Node Increment should be a Numeric value." 

Node Increment specified is not a numeric value. Please enter only numeric value. 

3. "Invalid Entry. Staring Node number should be < 10000." 

Node number cannot be more than or equal to 10000. Please reenter the starting Number below 
10000. 

4. "Invalid Entry. Node Increment should be < 10000." 

Node Increment value is too high. Node number cannot be more than or equal to 10000. Please 
reduce the Node Increment value. 

5. "Cannot determine product. Contact Program vendor for details" 

Some of the files required for the translator either moved or deleted. Please reinstall the product 
or contact program vendor for details. 

6. "Cannot initialize application. Contact Program vendor for details." 

Contact program vendor immediately. 

7. "Invalid Data Type. Expected = 'Real' Available = 'String'" 

a. When reading the Plant Design neutral file, one of the field values in a line is expected to 
be Real number format. But the field is filled with string format. Translator unable to read 
that field, so it will show an error message with a line number and Entire line Data and 
the above message. User needs to check that particular field and modify to Real number 
format and need to transfer the file. 

b. For example, Outer Diameter of a pipe is expected in Real Number format like “4”, But in 
neutral file it may be like “4inch”. In this case translator will give the above error message. 
User needs to remove “inch” from that field and save that neutral file then need to 
transfer. 

8. "Improper Bore or Weight Units. Check the Neutral File." 

Bore and Weight units entered in neutral file are invalid. Translator will expect Bore Unit as either 
“IN” or “MM” and Weight unit as either “KG” or “LB”. If any value other than the above is specified, 
the translator will show error message containing the line number, Entire line and the above 
message. User needs to check unit used then needs to transfer. 

9. "Wrong Neutral File. No Piping Elements available to Read..." 

Translator expects at least any one piping component present in the Neutral file. If not, it will 
show the above error message. User needs to check the Plant Design Neutral file. 

10. "Number of Fields available in the above Line < The Required Fields.” 

Translator expects some of the fields in a line from the Plant Design Neutral file. If not available, it 
will show the above said message with Line number and that particular line. User needs to check 
and correct that line and then need to transfer or contact program vendor for more details. 
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11. "Error in Mapping Data Base. Check the Data Bases." 

Improper changes were made to the Mapping Database. Check the entries made carefully.  

12. "Node number <Number> is defined twice in the Neutral file. Check the neutral file and 
proceed." 

The node number specified above is defined two times i.e., for the same node number X, Y and Z 
coordinate values specified in two places in the Plant Design Neutral file. User needs to check the 
neutral file. 

13. "The Node number exceeded 10000. Check the 'Start Node' and 'Node Increment'." 

During rearrange of node number, the new node is crossing 10000, which is not correct. Please 
reduce the  “Start Node number” and “Node number Increment” values and try again. 
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Appendix H 

Release Notes on checkSTRESS Version 11.01 

 Ten (10) new piping codes are added. 

o ASME B31.1 (1973) 
o ASME B31.12 (2019) 
o ASME Class 2 (2015) 
o ASME Class 2 (2017) 
o ASME Class 2 (2021) 
o ASME Class 3 (2017) 
o ASME Class 3 (2021) 
o IGEM (2012) 
o Z662 (2019) 
o EN 13941-1 (2019) 

 Following piping codes are updated 

o ASME B31.1 (2020) 
o ASME B31.3 (2020) 
o ASME B31.4 (2019) 
o ASME B31.5 (2019) 
o ASME B31.8 (2020) 
o ASME B31.9 (2020) 
o CODETI (2013) 
o EN 13480-3 (2020) 

Release Notes on checkSTRESS Version 10.00 

 Program is updated to be compatible with Visual Studio 2019 and .NetFramework 4.0. 

 New feature is added to transfer Limit Stop, Skewed Restraint and Snubber in Local Axes of the 
element. See Appendix D and Appendix E of this manual for details. 

Release Notes on checkSTRESS Version 9.30 

 Following piping codes are updated.  

o ASME B31.1 (2016)       

o ASME B31.5 (2016)       

o ASME B31.9 (2014) 

 UPDATED MATERIAL LIBRARIES: Material libraries for the following codes are updated. 

o ASME B31.1 (2016)       

o ASME B31.5 (2016) 

o EN 13480-3 (2012) 

 Fourteen (14) new Spectrum Libraries have been added corresponding to EL Centro (May 18, 
1940), Uniform Building Code (1991 Edition) and Nuclear Regulatory Commission (NRC) Guide 
1.60 [July 2014, Revision 2] in the folder “SpectrumLibrary”. These can be accessed through 
checkSTRESS > Edit Layout > Misc > Spectrums > Library. 

 New feature added to validate and fix the Branch SIFs defined in the stress layout before save. 
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Release Notes on checkSTRESS Version 9.20 

 New feature added to perform occasional stress evaluation using response spectra and/or static 
seismic ‘g’ loads. 

 New feature to transfer Spring Rate and Cold Load for to be designed hangers automatically to 
PIPESTRESS input file for checkSTRESS Nuke. 

 New feature added to export stress layout to PCF file from checkSTRESS layout edit option. This 
can be performed through Edit Layout > File > Export to PCF.  

Release Notes on checkSTRESS Version 9.10 

 Following piping codes are updated. 

o ASME B31.1 (2014)       

o ASME B31.3 (2014)  

 New feature added to show and print Hanger Report. 

 New feature added to transfer the model in ENGLISH units to checkSTRESS, if the value of the 
attribute "UNITS-CO-ORDS" is defined as "INCH" in PCF file for checkSTRESSPCF, 
checkSTRESS II PCF and checkSTRESS Nuke PCF. 

 Product is now fully compatible with Windows 10 and Windows Server 2012 or later. This version 
of product does not require .Net Framework 1.0 to be installed and may require .Net Framework 
2.0, if the same is not already enabled in Windows.  

Release Notes on checkSTRESS Version 9.00 

 Following piping codes are updated. 

o ASME B31.1 (2012)       

o ASME B31.3 (2012)       

o ASME B31.4 (2012) 

o ASME B31.5 (2013) 

o ASME B31.8 (2012) 

o EN 13480 (2012) 

o ASME B31.9 (2008)        

o CODETI (2006) 

 Hanger catalog "COMET" has been updated to include two new ranges, V4 and V5. 

 USER-DEFINED ALLOWABLE LOADS: New feature added to define "User Allowable Loads" for 
Anchors and Nozzles through Misc > User Allowables. The allowables thus defined are compared 
against calculated loads and printed in Support Load Summary outputs. If the calculated loads 
exceed the allowables, they are highlighted in red. 

 New feature added to read Thermal Anchor Movement (TAM) and Allowable Nozzle Loads 
defined in 3D Plant Design software. Refer to checkSTRESSPCF.pdf / checkSTRESSPDMS.pdf / 
checkSTRESSCADMATIC.pdf for details. 

 New feature added to print analysis summary. Using this feature, the following can be printed to a 
printer, a PDF file, a text file or a CSV (comma separated values) file. 

 a. Model input data  

 b. Code compliance results for ten (10) highest stress node points 



 

5577  

 c. Anchor / Nozzle Qualification Summary and 

 d. Status of Resting Supports / Limit Stops 

 e. Bill of Quantities, Weight & Centre of Gravity and Table of Contents 

 Static seismic "g" load is included in all versions of checkSTRESS. 

Edit Layout - Enhancements 

 New feature added to calculate local shell stiffnesses for nozzles connected to spherical shells. 

 New feature added to calculate Angular Stiffness of Bellows when the Axial Stiffness and Mean 
Diameter of Bellows are input.  

 Four digit year format is included in both "Print" and "Print to file" option. 

 New feature added to Copy and Paste rows (with Element (from Layout), Material, Section and 
Load properties). This can be performed through Ctrl+C and Ctrl+V.  This new feature will also 
allow to Copy and Paste multiple rows of layout. This can be performed through Layout Frame-
>Edit->Copy command. Multiple rows of Copy and Paste is valid only for Layout and NOT for 
Materials, Loads and Sections.  

 UNDO: can now perform an UNDO operation 1024 times (includes most user-input actions 
through Layout, List and Graphics windows). 

 REDO: can now perform a REDO operation 1024 times (includes most user-input actions through 
Layout, List and Graphics windows). 

 Length of the Material Name, Section Name, Load Name, Beam Material Name, Beam Section 
Name and Beam Load Name is increased to 5 from 3. 

 New feature added to define Anchor and Specified displacements in the local coordinate system. 

 New feature added to change Occasional load factor (k) for EN13480 piping code, available 
under Layout window > Options > Analysis > Code > EN13480. 

 DIN Flange library is now included in CheckSTRESS. 

 New feature added to combine current PIPE/BEND element with previous PIPE element. 

 New feature added to split an element into multiple segments. 

 New feature added to define Forces and Moments as part of Sustained Load / Expansion Load 
(T1) using Force Dialog.     

 New feature added to Find and Replace Element / Data types / Materials / Sections / Loads. This 
can be performed through Edit->Find and Replace or using Ctrl+H.     

 Improved title description for graphical plot of Stresses, Stress Ratios and Deflected shapes.   

 New feature added to Find and Repeat Find text inside comments. This can be performed 
through View->Find Text (Ctrl+Shift+F). Repeat Find can be performed by pressing "Ctrl+F3". 

 Double clicking on a comment row will allow the user to edit/copy/paste strings from Windows 
clipboard. 

 New feature added for redefining a model's vertical axis without affecting the layout of the piping 
system. Redefining a model's vertical axis will automatically redefine elements, data types, 
seismic G factors. 

 New feature added to show stress units in color coded stresses plot.     

 Double clicking the left mouse button on any area inside the Graphics window redefines that area 
as the center point of graphical display. 
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 New buttons added to define direction of Limit Stop and Skewed Restraint in Axial, Shear y and 
Shear z directions of piping while inputting. 

 Mouse Scroll Button Up and Down will Zoom In and Zoom Out the graphics. 

 New feature added to toggle lists. Ctrl + Left Arrow key for Previous List and Ctrl + Right Arrow 
key for Next List. 

 checkSTRESS now updated to have Node numbers up to 99,999 from the current 9,999. 

 New option added to include single weight of flange from ANSI and EUROPEAN flange library.   


